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Welcome to PhotoEdit

Welcome to the macXware  PhotoEdit  application, a powerful image editing tool that
lets you go beyond basic photo enhancement.

Featuring everything you need for advanced photo editing and creating professional
quality images, PhotoEdit also contains tons of image filters and effects, and an exclusive
Rbscript editor that allows the creation of unique filters and effects.

Registering macXware products

Registering your macXware products is important. Registration provides you with timely
access to the latest product updates, technical support, valuable information about new
product releases, access to free downloads, articles, tips and hints, and special offers.

You can register online at www.macxware.com. For more information about registering
a macXware product, please visit our website at www.macxware.com.

Installing PhotoEdit

Insert the PhotoEdit CD-ROM into your CD-ROM drive. Once the CD-ROM icon
appears on the Desktop, double click on it to launch the Welcome Screen. You can
double click on the icon that says “Install PhotoEdit” to launch the installer. Follow the
on-screen installation instructions.

For Mac OS9 computers, follow the same procedure as above but click on the “OS9
Installer” icon instead.

Customer Support

The web address for macXware is http://www.macxware.com.asp on the Internet. You
can access general customer service, product information, frequently asked questions
(FAQ’s) and technical support on this website. For additional support or specific
customer service related questions, you may also mail, telephone, fax or email. The hours
of operation are 9:00 am to 5:00 pm, Eastern Time (EST), Monday through Friday.

macXware
P.O. Box 642116
Omaha, NE 68164-2116

Telephone: 402-554-1400

Fax: 402-391-2413

Email: techsupport@macxware.com
comments@macxware.com
sales@macxware.com


http://www.macxware.com/
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Introduction

Becoming familiar with PhotoEdit

The PhotoEdit environment allows you to quickly and easily modify your photos:
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This is the image editing environment. Here you may use the available set of tools to

create what your heart desires.

Paint Canvas — This is where the your image editing and enhancement occurs. Use a tool

from the tool window by dragging or clicking here.
Tools — This window contains the tools you will use to modify your image.
Brushes — This window contains the eraser and brush tools.

Information — This window contains information about your image such as format, size,

and depth.

Colors — This window allows you to change the selected color (line or fill color) from the

tools window.
Patterns — This window allows you to change the pattern to fill the fill color with.




1. Basics

1-1. Tool Window

In this section, we’ll learn how to create a new image.

New Picture...

Next, the following dialog box should appear:

Open

Browse... %R New Image from Clipboard ~C#8V
Insert Picture... 36l

Close FEW

Save Y

Save As... O3S

Revert

Export Picture...

Page Setup...

Mew Picture

Width 640 " pixel B:
Height 480 pixel %

Depth | 16.7 Mill. Colors... [4]
Type CPICT B

il ™
L Cancel ) (——Hm—-’

Now let’s create your image!

To do this:
- Press New

To do this:
- Choose menu: File = New
- New Picture

This is the new picture dialog
box, here you may change the
settings of your image:

Width — The width of your
new image.

Height — The height of your
new image.

Depth — This is the number of
colors your image will
support.

Type — This is the format to
use for your image.
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Now the image editing environment should open with your new blank image:
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Paint Canvas — This is where image editing and enhancement occurs. Use a tool from
the tool window by dragging or clicking here.
Tools — This window contains the tools you will use to modify your image.
Brushes — This window contains the eraser and brush tools.

Information — This window contains information about your image such as format, size,

and depth.

Colors — This window allows you to change the selected color (line or fill color) from the
tools window.

Patterns — This window allows you to change the pattern to fill the fill color with.

Zoom — This button displays a menu to change the current zoom of the Paint Canvas.

Now you know how to create a new image!




1-2. Tool Window

Pencil {? ﬁ{f Paint brush
Selection L& Droolet
Eraser & | N Bucket
Line ~.|] Rectangle
Roundrect (D Oval
Zoom In @s 'El Zoom Out
Text A
. |;| Size o
Click to select color
type. Arrow shows =& [ Fill color
the color type that is -
selected. 3 - Line color
T

PhotoEdit uses the familiar painting tools found in modern day graphic editing programs.

To use a tool, first select it and then click or drag within the paint canvas.

¢ Pencil Tool - draws a pencil stroke with a single solid color.

¢ Paint Brush tool - draws a brush stroke using the selected brush in the Brush
Palette.

e Selection Tools - selects a portion of the Paint Canvas to apply transformations or
effects.

— It contains the following selection tools:
= Rectangle Marquee: selects a rectangle region.
= QOval/Elliptical Marquee: selects an oval region.
= Magic Wand: selects a group of closely related colors.
= Lasso: selects a region that you can draw out.

¢ Droplet Tool - picks up a color in the paint canvas.

¢ Eraser Tool - removes unwanted parts of your graphic using the selected brush.

e Fill/Bucket Tool - fills an area with the current selected color.

¢ Line Tool - draws out a line with the current line size and line color.

¢ Rectangle Tool - draws out a rectangle with the current line size and line color.
Click the same tool again to turn on/off shape filling.

¢ Roundrect Tool - draws out a rounded rectangle with the current line size and line
color. Click the same tool again to turn on/off shape filling.

e Oval Shape - draws out an oval with the current line size and line color. Click the
same tool again to turn on/off shape filling.

e Zoom In Tool - zooms in closer to the graphic

e Zoom Out Tool - zooms out from the graphic
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e Text Tool - Draws Text. Drag a rectangle to create a region for the text to lie
within.

*The line size is the size of lines or borders drawn around shapes.

PhotoEdit has two types of color: the Fill Color and the Line Color. The Fill Color is the
color used for filling an area/shape and painting. The Line Color is used for lines and
borders.

By clicking on the bucket or pen next to the Fill and Line Colors, you can change the
selected color. The selected color has an arrow next to it, and can be changed by either
clicking within the color box next to it then choosing a color from a color picker,
using the droplet tool, or changing the color in the Color Window:

&
R |

Now let’s start painting!

To do this:
g‘i@ - Switch to the Brush Tool:

=5l Use the Brush Tool and paint within the Paint Canvas:

~|
oo
® |2
A

[ Size o
gl
&

® 0 Untitled

100% »

1
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Now lets erase some of the strokes we made by using the Eraser Tool.

To do this:
- Switch to the Eraser Tool

- Erase some of the area you just painted:

(® O Untitled

//
//"’

100% 2

1.

Now let’s try using a shape tool.

v

To do this:
- Select the Rectangle Shape Tool
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W, Now we need to draw the shape, but we want to draw it unfilled. With the
shape tool selected, clicking on it the second time will turn the shape filling
Lot bl on or off:
& |
~|5| Do this:
o C§ - Click on the Rectangle Shape Tool again to turn off shape filling.
AE) - Now drag the shape on the Paint Canvas to create an unfilled rectangle:
A ® 0 Untitled
[ Size o
el ]
& |

/
///"’

100% W )

Now that you have some hands on experience with these tools, you should have no
problem using the rest.

1-3. Color Window

This is the Color Window. Use the color window to change the selected color in the

Tool Window.
& Color |
Color Bar
@‘ RGE Color Type
R
a~ —
G Color Sliders
.
B —— |
-

Color Bar — Drag within this bar to change the currently selected color.
Color Type — Click here to change the type of color in the Color Sliders.
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Color Sliders — Drag each of these sliders to change a property of the Color Type.
RGB - Red, green, and blue
HSV — Hue, Saturation, and Value
CMY - Cyan, Magenta, and Yellow

1-4. Patterns

Pattern

This is the Pattern Window, click on a

1-5. Brushes

) . s| This is the Brush Window, click on a brush to change the current brush
...................... m on the Brush or Eraser Tool
.
Ll
...................... .
"

1-6. Selecting & Moving

In this section, we’ll learn how to use the selection tools:

Click and hold down the selection button from the tool window to change to
another selection tool.

Do this: e
- Select the Lasso tool: =

pattern to use when filling with the fill color.
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Now let’s drag out a selection using the lasso tool.

To do this:

- Drag the lasso tool over a region in the Paint Canvas to select them:

Untitled

100% b

2

Now that you have a selection, you may move the selected graphic by clicking and
dragging your mouse over the selected region.

Now you have learned how to select using the selection tools. You may use any of the
other selection tools to select a graphic region (7o switch to another selection tool, click
and hold the mouse over the selection tool from the Tool Window).

1-7. Modifving Selections

In this section, we’ll learn how to use the selection in more depth, and how to modify the

shapes of selections.

Selection Tools:

The Select menu contains several tools:

Select = \Talls0 ®ira:
Blend Mode >

Bind to Edges
Unbind to Edges

Inverse Selection |
Trim Selection

Always Bind to Edges “C#E
Use Selector Only O3U

Bind to Edges — Wraps the selection around the empty
region (white) of the selected graphic.

Unbind to Edges — Unwraps the selection to its bounding
rectangle region.

Inverse Selection — Selects the unselected region and
deselects the selected region.



Trim Selection — This option resizes the bounding rectangle region to include only non-
empty regions.

Always Bind to Selection — This option always wraps around the non-empty graphic
regions that you select.

Use Selector Only — This mode allows you to apply a filter or an effect to the selected
region without actually modifying that region until you deselect.

Now let’s switch the selector mode to use the Selector Only.

This mode allows you to apply a filter or an effect

Blend Mode » | to the selected region without actually modifying

Bind to Edges that region until you deselect.

Unbind to Edges

Inverse Selection et To do this:
Trim Selection - Choose menu: Select 2 Use Selector Only
: - Change the tool to the lasso tool:
Always Bind to Edges “CHE J |
Use Selector Only [ a8 E:ﬂ o
1
~
: Ol
Now do this: Em
- Draw the selector over a region. x
- Choose any effect you please from the Effects menu.
Now you have applied an effect using the Selector Only mode. &
&
Now try this: —

- Move the selector over another graphic by dragging within the
selected region.

What you’ll notice is that the recent effect gets discarded, but the selection remains the
same. This mode allows you to easily apply effects to certain regions without actually
modifying the original image.

Now try this:
- Apply another effect to the selected graphic.
- Deselect by clicking outside of the selected graphic (or from menu: Edit 2 Deselect)

Now you’ll notice that the effect has been applied to that region. In the Use Selector
Only mode, you cannot move the selected graphic, only the selector; you may only add
an effect/filter to the selected graphic. When you are satisfied with the filter, deselect to
add the change into your image.

Let’s add an effect to the selected region of your image.
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To do this:
- Using the lasso tool, draw out a selection over the region that you want to select.

If you have the Use Selector mode on, you may move the selector to select a different
graphic region.

By holding the shift-key while you drag out a new selection you may add another region
to the selected graphic. By holding the option-key while you drag out a new selection,
you may remove parts of the selected region.

Do this:

- Hold the shift-key and drag out a new
selection over a region you want to add to
your selection:

Now your selection has expanded to the new region:

®0 Capture 61.m

100% b ) ~ |

Now let’s apply an effect to our selected graphic region.
To do this:

- Go to menu: Effects

- Choose a filter or an effect from the Effects menu

Now you have applied an effect or filter to the selected region of your image.

You have now learned the basics of image editing and manipulation!
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2. Editing and Technigques

2-1. Using the Edit Menu

In this section, we’ll learn how to use the Edit menu to edit your image:

Revert Image

Cut

Copy

Copy Normal
Paste Picture
Clear

Select All
Deselect

X
1

#Y

A
3D

Image Size/Depth...

Undo /Redo — This menu will undo or redo the
last action applied to your image.

Revert Image — This menu reverts the image to
the image that was first loaded. If the image did
not load from a file, then reverting it will show a
blank image.

Cut — This menu deletes the selected image and
copies it along with its mask onto the clipboard.
Copy — This menu copies the selected image
along with its mask onto the clipboard.

Copy Normal — This menu copies the selected
image without the mask so that it can be used in
other programs.

Paste Picture — This menu pastes the previously
copied image onto the clipboard.

Clear — This menu deletes the currently selected
image.

Select All — This menu selects your entire image.

Deselect — This menu deselects your graphic selection and draws it onto your image.
Image Size/Depth — This menu shows you a dialog box that allows you to change the
size and depth of your image:

Width
Height

Depth

— Width — The width of your image
40 I IS . .
; _M Height — The height of your image.
480 pixel |4} Depth — The number of colors your
16.7 Mill. Colors... [4) image supports.

2-2. Blend Modes

’ Cancel ‘ ( 0K )

Before you begin, you need to have an image opened.
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The graphic blending modes allow you to blend the selected graphic with the graphic
underneath of it. By blending two images together, you can create cool looking
transparent effects.

Let’s begin blending images!
To do this:
- Insert an Image from a file (from menu: File 2 Insert Picture), or paste an image from

the clipboard onto the Paint Canvas.

Now let’s change the blend mode.

Select

Mask Blend Mode To do this:
as
Mask 2 - Go to menu: Select 2 Blend Mode
- Bind to Edges
Transparent White =
3D Anaalvoh Unbind to Edges
B Inverse Selection Rt
Transparent Trim Selection
Iransparent Weight... Always Bind to Edges “C#E

Use Selector Only 43U

There are several Blend Modes:

Mask — This option will make the graphic underneath the selected graphic its mask:

Mask 2 — This option will make the selected graphic the mask of the graphic underneath:




Transparent White — This option will remove all the colors that are completely white
from the selected graphlc

3D Anaglyph — This option will create an anaglyph image by combining 2 of the same
image shot at slightly different angles to create a 3D illusion when viewed through 3D
glasses:

Transparent — This option will make a certain percentage of the selected image
transparent. You can set how transparent you want the selected image to be by changing
the transparent weight.
-Transparent Weight — This menu will open a window allowing you to change
the transparent weight.

Now do this:
- Choose one of the blend modes from above to see how they look like with your image.
- Deselect to apply the image blending.

That’s all there is to blending images together!
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2-3. Masking

Before you begin, you need to have an image loaded in the Image Editor.

In this section, you’ll learn how to modify the mask of a selected image.

The mask is a grayscale image that determines which part of your image would be
transparent (or see-through) and by how much. A completely black area would not be
transparent, while an area of complete white will be completely transparent. The lighter
the shade, the more transparent the color will be; the darker the shade, the less
transparent.

Before we can edit an image’s mask, we need to have an image selected.

To do this:
- Insert an image from a file, or paste one from the clipboard.

Now with the selected image, let’s edit its mask.

To do this:
Image Filters... - Choose menu: Effects 2 Mask...

Selection Effects...

Simple
Filter
Adjustments
Transform
Motion

yvywwy

Plugins [ 2

The current window will hide, and the Mask Editor will open.
The Mask Editor is just like the Image Editor except the Mask Editor shows how the
selected image would look over your image.

Painting with white (or using the eraser tool) on the mask would make the image
transparent:

If you make a mistake erasing the
image’s mask, you can paint it back in
with black.

You may use the selection tools to fill in
or delete parts of the mask.

You can insert or paste a ready made
mask into the Mask Editor. If the mask
uses black as transparent and white as
solid, you can simply invert the mask to
get it working.




Now try this:
- Use the eraser tool and mask out an object in your image:

Gps: \

- Use a finer eraser brush to
perfect the edges.

- When you make a
mistake, you can paint it
back in using the brush tool

/

Now do this:
- When you are happy with your masking, close the window.
-When it asks you to save the mask, click “Save” to set the mask of your selected image.

Now you should be back to the Image Editor with your selected image masked; you may
move it anywhere you please. Deselect to apply the selected graphic on your image.

That’s it; you have successfully masked an image. You can also place masked images
over your movies in MediaEdit Pro!

2-4. New Image From Clipboard

In this section, we’ll learn how to create an image you copied to the clipboard. Before we
begin, you must already have an image in the clipboard.
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This feature is useful for putting an image away while preserving its mask, or even allow
you to quickly edit/create an image straight from the clipboard.

Open >

Insert Picture... 881

Close BW
Save ®8S
Save As... O #RS
Revert

Picture Settings...
Export Picture...

Page Setup...
Print...

Mew Picture...

Browse... %B New Image from Clipboard .

To do this:
- Choose File 2 New = New
Image from Clipboard

Now a new image will be created with the image from the clipboard selected:

8 0 Clipboard Image

That’s all there is to it. Now you’ve learned how to create an image straight form the

clipboard!

2-5. Resizing Selected Image

Before we begin, you must have an image already selected ready to be resized.

In this section, we will learn 2 ways to resize a selected image.



1. Resizing from the menu:

Effects
Image Filters...
Mask...

Simple
Filter

Adjustments

Transform Flip Horizontally

Plugins Flip Vertically
Rotate 90°

To do this: Choose Menu: Effects = Transform = Resize...

Next the following dialog box should appear:

Resize
Width 100 %
Height 100 %

( )
(cancel) € oK)

Try this:

Width — Input the width you would like
to scale the selected image by.

Height — Input the height you would like
to scale the selected image by.

- Input 50% for both width and height

-  Press OK

Now your image dimensions should be reduced by 50%:

86 Clipboard Image

100% »
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2. Resizing from the Paint Canvas:

At the corners of a selected image’s bounding rectangle, there are boxes that you
may drag to resize:

80 Clipboard Image

100% » L

To do this:
- Drag a corner from the selected image to resize. Hold the shift-key to resize the
selection proportionally.

Now you have learned the two ways to resizing your image!
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3. Image Enhancements & Filters

3-1. Adding Effects or Filters to Your Image

Before we begin, you will need to have an image opened.
In this section, we’ll learn how to add effects or filters to parts or all of your image.

To do this:

- Switch to the rectangle marquee selection tool

- Using the rectangle marquee tool, select an area of the image that you want to add an
effect/filter too (if you would like to select the entire image, choose menu: Edit = Select
All).

Your image should now be selected like this:

@ PhotoEdit File FEdit View Texi Effects Select Window Extras ¢ @ = ) @249 Sun223PM % PhotoEdit
Untitled Q Information

Format:  PICT
Size: 576432
Depth: 32

&[res ~|

e ——
a

Now let’s add an effect or filter to that selected region. You may select an effect or filter
from a submenu within the Effects menu.
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To do this:

Image Filters... - Go to menu: Effects
Mask... - For our example, let’s invert the selected portion of your image by

Simple choosing menu: Effects = Simple = Invert
Filter
Adjustments
Transform
Plugins
—

b A 0

Now the effect or filter you have just chosen has been applied to your selected region:

@0 Untitled
v L]

Now you’ve learned how to add effects or
filters to parts or all of your image.

3-2. Removing Red Eve

In this section, we will learn about removing red eyes.
Before we begin, you must have an image loaded that contains red eye.

Do this:
- Zoom into the eye area using the zoom-in tool:
8060 Clipboard Image
[N

- Switch to the lasso or oval marquee selecting tool for selecting the eye (whichever you

prefer).
- Carefully select around the pupil like below:

®@0C Clipboard Image

.
v
B00% b 4 ( )b'/a
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- Now select the second eye by holding the shift-key while carefully selecting
around the second pupil like below:

Clipboard Image

Now that you have the red eyes selected, let’s remove them by adjusting their color.
Effects To do this:
e e - Choose menu: Effects 2 Adjustments = Adjust Colors

Mask...

Simple

Filter

Adjustments Contrast...

Transform Adjust Colors... .,

Plugins Change Color...
Remove Color...
Color Filter...
Gamma...

Tint...
Lighten...
Darken...

The following dialog box should appear:

Adjust Colors

Color Type — The type of color you only want to
adjust. By choosing Master, you are adjusting all the
colors on your image.

Hue — Color; you may shift the color of the image by
sliding left & right.

Saturation — Slide the bar right to soak up the colors.
Slide the bar left to wash out the colors.

Color Type: [ Master 4] Lightness — Slide this bar right to add white to the
_ i ~123° colors of your image. Slide the bar left to add black to
= Saturation . the colors of your image.
= Reset — Resets all your settings with no color
Fohtess +0% adjustments.
©

[ Reset | [ Cancel )

Now let’s adjust the color of our selected eye.

To do this:

- Shift the hue from red to the subject’s eye color.

- Shift the saturation up or down until it looks natural.

- If needed, you may also shift the Lightness, otherwise just leave it at 0%

Page 25



Page 26

Now we’re done adjusting the eye color from red.
Do this:
- Press OK

Now the red eye should be gone, and the eyes should be their natural color:

®0C Clipboard Image

Congratulations, you’ve learned to remove red eyes from a photo!

3-3. Color Adjustments

In this section, we’ll learn how to adjust the colors of your image, but before we begin
you must have an image loaded.

Do this:
- Switch to the rectangle marquee selection tool (or another selector tool if you wish).
- Using the selection tool, select an area of the image that you would like to adjust to.

Effects
Image Filters. ..

=== Now let’s adjust the image color!

Simple
Filter

Adjustments Contrast... TO do this.
Transform Adjust Colors... .
Motion Change Color... . .
wnecoer.. | - Choose menu: Effects = Adjustments = Adjust Colors...

Plugins Color Filter...
Gamma...

Tint...
Lighten...
Darken...

Adjust Colors The following window should appear:
Color Type — The type of color you only want to adjust. By
choosing Master, you are adjusting all the colors on your
image.
ST W - Hue — Color; you may shift the color of the image by sliding
Color Type: { Master_18) left & right.
s % | Saturation — Slide the bar right to soak up the colors. Slide
oo o the bar left to wash out the colors.
0 - Lightness — Slide this bar right to add white to the colors of
L'ghge” = your image. Slide the bar left to add black to the colors of
~——— | yourimage.
€5 | Reset - Resets all your settings with no color adjustments.




You may adjust the Hue, Saturation, and the Lightness of the color on the selected image.
Let’s remove half of the colors on our image.

To do this:
- Slide the Saturation slider bar to about —25%

You’ll notice that the color on your image now looks grayish.
You may shift the other options to see how the images changes.

Now let’s only adjust a specific color such as red.

Adjust Colors

To do this:

- Change the color type from the Color Type pop up
menu to “Reds”

- Adjust the saturation to about +25%

J P -
Color Type: | « Master

Yellows

— -
Greens
Cyans -26%
Blues |
Magentas
ULIgnthess T 0%
-
Reset Cancel ﬁ

Now what you get is an image with the other colors faded and the reds looking normal.
You may adjust the “Reds” saturation higher to make it stand out more. If you would like
to adjust other colors, you may choose them from the Color Type menu. By shifting the
Hue, you can change the reds in your image to blues.

Do this:
- When finished, press OK.

That’s the basics of color adjustments.
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3-4. Replacing Colors

Before we begin, you must have an image loaded.

In this section, we’ll learn about changing a certain color on your image.

Do this:

- Select the region of the image that you would like a certain color to be changed.:

® 0 Clipboard Image

Now do this:

- Choose menu: Effects 2 Adjustments = Change Color ...

The following dialog box should appear:

Change Color

Weight: 30%
= ©

Hue Angle: 207°

al |e s

Change Color: D

Shift Hue 0%
hvi
Shift Saturation 0%
hvi
Shift Lightness 0%
hvi
[ cancel ) @

Weight — This is the differences in color of
the Change Color. You may adjust it to
accept more or less differences in colors.
Hue Angle — This is the color (or hue) of
the Change Color. You may use the scroll
bar to shift the color.

Change Color — This is the color on your
image to change. Click on the box to
change the color.



Shift Hue — Allows you to shift the color (or hue) of the color to change in your image.
Shift Saturation — Allows you to shift the saturation of the color to change in your
image.

Shift Lightness — Allows you to shift the lightness of the color to change in your image.

Change Color DO thiS'
Weight: 30% - Click on a color on the preview of your
v image to select the Change Color from
Hue Angle: 203° your image.
4l (& ] s

Change Color: D

Shift Hue 0%
hv
Shift Saturation 0%
b s
Shift Lightness 0%
L
f rancal M
{ Cancel )} @

Now let’s change the color that we selected to change.

To do this:

- Shift the Hue, Saturation, and Lightness until the color you're changing changes to the
color you want.

- If the color does not change the entire area you want or if it changes too much, you may
adjust the colors you want to change by shifting the Hue Angle of the Change Color or
the Weight of the Change Color until it covers the area you want.

- When the image in the preview box is what you want, then press OK to add the effect to
your image.

Now the color on your image should change:

Clipboard Image

Now you’ve learned to change colors on
your image!
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3-5. Keying-Out Color

Before we begin, you will need to have an image opened. You will also need to have a
second image ready to be imported. The second image must have a region of the same
color (works best with a blue or green background) to be removed.

In this section, we’ll learn how to use a key color to generate a mask for the selected

image.

Now let’s insert the second image you have.

File
MNew »
Open »
Browse... 3B
Insert Picture... .
Close ®|W
Save S
Save As... O3S
Picture Settings...
Export Picture...
Page Setup...
Print... P

Do this:
- Choose File = Insert Picture...
- Select your image from the next window and click Open.

Now the inserted image should be selected like below:

80

100% »

Clipboard Image

N




Now let’s remove a color from your image so that it becomes transparent over your first

image underneath.

To do this:

Image Filters...
Mask...

Simple >
Filter >
Adjustments  » Contrast...

Adjust Colors...
Change Color...

Transform
Plugins

b A 4

Color Filter...
Gamma...

Tint...
Lighten...
Darken...

Now a window should appear:

Remove Color

Tolerance: 11%
7
Hue Angle: 355°
o S
Key Out: I:I

Shift Color Transparency +5%

—

hv

Smooth

Shrink Edge

Av

( )
( cancel ) oK)

- Choose menu: Effects 2 Adjustments 2>
Remove Colors...

Tolerance — This is the
differences in color of the
Key Color. You may adjust
it to accept more or less
differences in colors.

Hue Angle — This is the
color to key out. You may
use the scroll bar to shift the
color.

Key Out — This is the color
to key out. Click on the box
to change the key color.
Shift Color Transparency
— Allows you to change the
transparency of the Key
Color.

Smooth — This option will smooth out the edges of the clip over your movie. You may

adjust how much to smooth the edges.

Shrink Edge — This option will shrink the edges. You may adjust how much of the edges

to remove.
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Now let’s remove a color from our image.

Remove Color .
To do this:
Toleranca: 11% - Click on a color on the preview
—= of your image to select the Key
Color from your image.
Hue Angle: 193°
' [ ] s
Key Out: El
Shift Color Transparency +5%
b
Smooth
—
"
Shrink Edge
=
4 P A
Cancel E-—BK—',

Now let’s fine tune the transparent area.

To do this:

- If the color is not removed from the entire area you want or if it takes out too much, you
may the adjust the colors you want to change by shifting the Hue Angle of the Key Color
or the Tolerance of the Key Color until it covers the area you want.

- Shift the Shift Color Transparency slider to adjust the transparency of the Key Color.

- Shift the Smooth slider to smooth out any jagged edges.

- Shift the Shrink Edge slider to eliminate the excess colors on the edges of your image.

- When the image in the preview box is what you want, then press OK to add the effect to

your image.

Now your imported image should have transparent areas over your original image:

Clipboard Image

Now you’ve learned to remove a color
from your image. You may fine tune the
transparency further by editing its mask.



3-6. Brightness and Contrast

Before we begin, you will need to have an image opened.

In this section, we will learn to adjust the Brightness and Contrast on your image.

Effects

Image Filters...

Mask...

Simple [ 2

Filter [ 3

Adjustments p Contrast...

Transform [ 2 Adjust Colors...

Plugins > Change Color...
Remove Color...
Color Filter...
Gamma...
Tint...
Lighten...
Darken...

Now the following dialog box should appear:

Contrast & Brightness

__ Preview:

Contrast: 1%

| () e
Brightness: 0

< e s

’:Cancelj E’ OK *3

To do this:

- Select the area on your image that you
would like to adjust its contract and/or
brightness.

- Choose menu: Adjustments = Contrast...

Contrast — Shift this scroll bar to
change the contrast on your image.
Brightness— Shift this scroll bar to

change the brightness on your image.

Do this:

- Adjust the brightness
- Adjust the contrast

- When done, press OK.

That’s all there is to changing the
contrast or brightness on your image!
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3-7. Gamma

Before we begin, you will need to have an image opened.

In this section, we will learn to adjust the gamma on your image.

Image Filters...

Mask...

Simple [ 2

Filter >

Adjustments  » Contrast...

Transform
Plugins

Adjust Colors...
Change Color...
Remove Color...
Color Filter...

yv

Tint...
Lighten...
Darken...

Next this window will appear:

To do this:

- Select an area on your image that you would
like to adjust the gamma.

- Choose menu: Effects 2 Adjustments 2>
Gamma...

Cama

0.00

All: e —
L
|
Red: -
L
Green: = 0.00

-

Blue: 6

0.00

All — Shift this slider to adjust the
gamma on your image.

Red — Shift this slider to adjust only the
red gamma on your image.

Green — Shift this slider to adjust only
the green gamma on your image.

Blue — Shift this slider to adjust only the
blue gamma on your image.

Do this:
- Adjust the gammas.
- When done, press OK.

Now you’ve learned to change the

f;Cam:eI ) f 0K “3

gamma on your image!




3-8. Sharpening

Before we begin, you will need to have an image opened.
In this section, we will learn to make your image sharper. There are many different types
of image sharpening filters, but we will only discuss the basic sharpening filters in this

section.

Do this:
- Select the area on your image that you would like to sharpen.

There are two types of image sharpening filters:

Sharpen — This filter sharpens your image:

80 chingy.jpg

Heavy Sharpen — This filter applies a much heavier sharpen filter to your image:
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86C chingy.jpg

Now do this:
- Choose the type of image sharpening filter you would like to apply:
1. Sharpen — Choose menu: Effects =2 Filter 2 Sharpen
2. Heavy Sharpen — Choose menu: Effects =2 Filter - Heavy Sharpen

Now your image should look sharper than normal.

3-9. Smoothing
e0°C chingy.jpg

In this section, we will learn to
make your image look softer or
smoother by applying a
smoothing filter. Before we
begin, you will need to have an
image opened.

Here is a very sharp image that
looks very unnatural. By using
the smooth filter, we will be able
to smooth out the sharp edges
giving it a natural look.

Page 36




Do this:

- Select the area of your image in which you would like to smooth out.
- Choose menu: Effects = Filter = Smooth...

The following dialog box should appear:

Smoaoth

Weight — Drag this slider to adjust the
heaviness of the filter. The higher the
weight, the heavier the smoothing.

’ Cancel \E QK 3

Now do this:
- Adjust the weight until the image looks smoothed enough.
- When done, press OK.

Now your image should look smoother than before:
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® 0 chingy.jpg

100%

3-10. Color Filtering

In this section, we will learn to adjust the red, green, and blue color channels in your
images. Before we begin, you will need to have an image opened.

Do this:

Color Filter

All: 6 ~
|
Red: +r 0%
St
Green: o 6 s (0%
Blue: = —F » 0%
St

“’CanceI\ f 0K *)

- Select the area on your image in
which you want to adjust the color
channels.

- Choose menu: Effects >
Adjustments = Color Filter...

Now the following window should
open:

All — Shift this slider to adjust the
level of white on your image.
Red — Shift this slider to adjust
only the red level on your image.



Green — Shift this slider to adjust only the green level on your image.
Blue — Shift this slider to adjust only the blue level on your image.

Do this:

- Adjust the values of Red, Green, and Blue like below:

Color Filter

All: =
hv
|
Red: — -14%
L
Green: — - -2T%
v
Blue: —} . -54%
L

( Cancel y E"—OK—")
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Now your image should have a red tone.

Now do this:

- Adjust the red, green, and blue levels until your image has the correct tone.

- Press OK when complete.

Now you’ve learned to adjust the color levels on your image.

3-11. Image Filters

In this section, we will learn to apply a collection of filters on your image. Before we
begin, you will need to have an image opened.

Effects

Image Filters... Do this:
e - Choose menu: Effects 2 Image Filters...
Simple >
Filter »
Adjustments P
Transform »
Plugins * | The window below should appear:
1S 1 Image Filters
This is a
__ Before —afiar

of image filters
may add to your

Before — This is
before adding
After — This is
after adding the
Filter Type —
list of filters you
choose from.
that you would
apply to your
Weight — This is
of the filter.

)

|l
Filter Type: Weight: 1
! Unweighted ... 9‘ ol y -
# Red
Green ——
™ Blue (_Cancel )

Red — Check this option to apply the selected filter to the red channel.
Green — Check this option to apply the selected filter to the green channel.
Blue — Check this option to apply the selected filter to the blue channel.

Now try this:

- Select a filter from the Filter Type list.

collection
which you
image.

your image
the filter.
your image
filter.

This is the
may

Select one
like to
image.

the weight



- Change the weight if needed.
Now your new image should appear under the After box.

Now do this:
- Once you have selected the filter you like, press OK to add the filter to your image.

Now you have applied a filter using the collection from the Filter window.

3-12. Creating 3D Anaglyphs

In this section, we will learn to create 3D images that are seen through red/blue or
red/cyan 3D glasses in a few simple steps.

First, we need two identical images that are taken at slightly different angles (about 10
degrees apart).

Now let’s combine these two images to create the 3D effect.

Do this:

- Open the image that is more to the right into PhotoEdit.

- Now insert the second image (the image more on the left) by choosing menu: File >
Insert Picture...

Now let’s change the blend mode.

Select To do this:
Blend Mode 2 :::: = - Choose menu: Select 2 Blend
B'nd_ teksigus Transparent White Mode 2 3D Anaglyph
Unbind to Edges 3D Anaalvbh
Inverse Selection R |
Trim Selection Transparent
Transparent Weight...

Always Bind to Edges “C#E

Use Selector Only O3%U

Now do this:

- Align your image until you see the least amount of red or cyan you can possibly get.
You may purposely move them further apart for a more 3D look.

- For best results, be sure the excess cyan color is on the left and the excess red color is
on the right.

- View your image through your 3D glasses until it looks right.

- Deselect to blend the images together.

Now you should have a 3D anaglyph image:

Page 41



®@0 0O chingy.jpg

3-13. Creating a Bevel Button

In this section, we will learn how to create simple bevel buttons using the bevel filter.
Before we begin, you will need to have an image opened.

Do this:
- Select the Rectangle Marquee tool.
- Drag a rectangular area on your image. This selected area will be used as

g
;hr the button. You may add text to label the button before selecting the area:

o

> 20 /8 E

l= &
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®0 chingy.jpg

|

100% 4 /4

Now let’s bevel the area so it could be used as a button.

Image Filters...
Mask...

Simple

Blur

Adjustments » Sharpen
Transform > Heawy Sharpen
Plugins [ 2 Smooth...

Noise...
Noise Mono...
Fracture...
Pixelate...
Threshold...
Ripple...
Swirl...
Twirl...
Wave...

following dialog box should
appear:

Weight — Change the weight to
change the amount of the button’s
bevel.

Do this:

- Choose menu, Effects =2 Filter = Bevel...

Bevel

My Bevel Button

12%

[ cancel ) H(—’

Now
the
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To do this:
- Slide the weight until the button’s bevel is what you want.
- Press OK to create your new bevel button:

My Bevel Button
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4. Extras

4-1. Preferences

In this section, we’ll take about the Preferences in PhotoEdit.

PhotoEdit

About PhotoEdit...
Check for updates...

Preferences...

sServices | 3

Hide PhotoEdit 3H
Hide Others CHH
Show All

Quit ®0

To access the preferences,

Do this:

- Choose menu: PhotoEdit = Preferences...

- If you’re using Mac OS 9, choose menu: Apple 2>
Preferences...

The preferences window should open:

8 C Preferences

Options

[ Keep brushes the same size

# Don't save over the ariginal images

Keep brushes the same size:
Turn this option on to make the brush the same size on the screen when you zoom in or

out of an image.

Don’t save over the original images:
Turn this option on to only open a copy of the original image without harming the

original file. When you turn it off, the original file will be modified when you save the

image.
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4-2. The Media Browser

In this section, we’ll learn about the Media Browser.

The Media Browser is a great tool for browsing image and movie files on your hard drive
or disks. It has the ability to view images at any size directly from the browser. With its

unique slideshow feature, you can easily do a slideshow from a folder of images.

Let’s open the Media Browser!

File

New .

Open To do this:

Browse 5% .
- Choose menu: File 2 Browse...

(58

®W

Capture... ®RC

Expor Plcure.

Export Image Sequence

Convert to QuickTime...

Preview Movie CRP

This is the Media Browser:

Media Browser

000

I_ Touc Sai Pictures

Media View: 82 item(s) found
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Current [
Directory

DSCO0104.JPG DSCO0105.JPG

Folder

List
DSCO0107.JPG DSCO0108.JPG
DSCO0111.JPG DSCO0139.JPG
lﬂ 3
-

View Slideshow. T

L)

D5CO0106.JPC

Slideshow

D5CO010%.JPC

DSCO0140 JFC

o

CIEIE

Zoom

Navigation

Media
View




Current Directory — This is the current folder your are in. Click the icon beside it to

move to the parent folder. Click on the directory name to show media files within the

Current Directory.

Folder List — This is the list of folders in the Current Directory. Double-click on a

folder to change to that directory.

Navigation — These buttons allow you to navigate to the parent folder, root, home folder,

document folder, and the desktop folder.

Media View — The Media View creates a preview of movies and images within the

current directory or a selected folder from the Folder List. Double-click on an image to

edit it.

Zoom — This slider zooms the Media View. You may zoom in to the selected image by

sliding the slider to the right. Sliding to the left will zoom out the Media View revealing

more images.

Slideshow — Click here to view a slideshow of the images within the Media View.
Slideshow settings — This window lets you to change settings on your slideshow.

Slideshow Settings

Cycle Delay — The delay between each slide.
Cycle Direction — The direction to play the slide.
Cycle Direction:  [Forward 3} | mages Visible — This is the number of images to
Images Visible: 1 show at the same time in the slideshow.

[ Show Labels | Settings Show Labels — Turn this option on to display the
name of the media file in the slide show.

Cycle Delay: 5 seconds

[ Cancel ) ( oK ’

Do this:
- Browse to a folder with some images on your hard drive.

You’ll notice that all of your images will appear in the Image View.
The Folder List to the left will show a list of your folders in that directory.

Let’s zoom into an image.
To do this:
- Select an image you want to see a larger preview on.

- Drag the Zoom slider all the way to the right.

Now you’ll notice that the selected image fills the Media View.
You may double-click on an image in the Media View to edit that file.

Now you’ve mastered the Media Browser!

4-3. Custom Brushes

You may create your own custom brushes if the current set of brushes do not fit your
needs. All the installed brushes are located in the Brushes folder of the PhotoEdit folder;
you may add or remove brushes by dragging brushes in and out of that folder.
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The brush editor is a unique tool to create your own custom brushes.

Let’s open the brush editor.

Extras

Script Editor

To do this:

Brush Editor

Now the Brush Editor window should open:

Brush Maker

800

Color.

Size: 32

Line Gap:

4
Gap:
B

Fill Time
o

Load...

U

Save...

N

Load — Loads a brush file into the Brush Editor.
Save — Saves the current brush to a brush file.

- Choose menu: Extras = Brush Editor

Edit Brush — Click here to edit the
brush’s mask with the Image Editor
Import — Selects an image file to use
as the brush’s mask.

Color — This is the current color to
use for painting.

Size — This is the size of the brush (in
pixels). You may resize it by
changing this value.

Line Gap — This is the space between
each brush for long strokes.

Gap — This is the space between each
brush for short strokes.

Fill Time — This is the time in 1/60"
of a second to redraw the brush.

Now you may create your own brushes, if you don’t know where to start, you may load

one of the existing brushes from the brush folder.

After setting your brush settings and creating the brush’s mask, you may test your brush

on the white canvas area to the left.

Once you are satisfied with your brush, you may save it to a file. To use the brush, you
must copy the brush file to the Brushes folder within the PhotoEdit folder, and restart

PhotoEdit.



4-4. The Rbscript Language and what you can do with it

In this section, we will learn about using scripts to create custom macros, transitions,
filters, and effects.

We are not going to discuss how to use Rbscript, but rather what we could do with them.
Otherwise it is a manual in itself. Rbscript scripts use the BASIC programming language.
Programs such as REALDbasic and Microsoft Visual Basic also use the BASIC
programming language, so if you want to learn how to use Rbscript, they are a great way
to start.

Macros are put into the Scripts folder. Transitions and effects plug-ins are put into the
Plug-ins folder.

You may access macros from menu: Extras = Scripts

Extras

Script Editor
Brush Editor

Scripts Go To End
Open Document
Select All

You may access the effects plug-ins from menu: Effects 2 Plugins
Transition plug-ins appear at the bottom of the list in the transition window.

Starting your script by opening the Script Editor:
Extras

Script Editor Do this:
B,uh aior ¥ - Choose menu: Extra = Script Editor

Scripts >

This is the Script Editor:

806 Plugin Editor
Name: | Untitled Type: Custom { Run )
f f b Y
Code Editor: ‘ [ Transition '\_) 0% (_/ Check )
Close ’CmT* Save Save As...
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Name — Name of the Script as it appears in the program.
Type — This is the transition type (i.e. FADE, WIPE); you must turn on Transition to set
a transition type.
Transition — Check this option to make this plug-in a transition instead.
*The slide allows you to change the frame of the transition.
Code Editor — Enter your code here. If you would like to see an example code, open the
sample plug-ins included with MediaEdit Pro in the Plug-ins folder.
Run — Runs the code.
Check — Checks your code’s syntax.
Open — Loads a plug-in file.
Save — Saves the current plug-in.
Save As — Saves the current plug-in to a new file.

eNif ——— W:Igm[[ T Let’s do a sample effect.

Code Editor: ‘ [ Transition ) 0% (V chec)

graphic imvert To do this:
- Enter “graphic.invert” into the code
editor.
- Press Run
Presto! It should show an inverted image.
You may see a list of image effects and

Caiose ) Took 0.1 secands). Copen.) * woe  (sens.) | filters in the list on the next page.

The Following are Classes, Commands, and Functions that are allowed in Rbscript:

Global Picture Objects:
graphic as picture//the graphic of the selected image or the image to do effects on
framepicture as picture//the current frame image

All operators are supported:
+-*/\Mod

<=><=>=<>

And Not Or

All three forms of comment are supported:
'/l REM

Standard library functions:

Abs(Double) As Double

Acos(Double) As Double

Asc(String) As Integer // letters between 0 and 127 only
AscB(String) As Integer // no high-ASCII characters
Asin(Double) As Double

Atan(Double) As Double

Atan2(Double, Double) As Double
BitwiseAnd(Integer, Integer) As Integer
BitwiseOr(Integer, Integer) As Integer
BitwiseXor(Integer, Integer) As Integer

ByRef option

ByVal option



CDbl(String) As Double // identical to Val()
Ceil(Double) As Double

Chr(Double) As String

ChrB(Double) As String

Const name = value

Cos(Double) As Double
CountFields(String, String) As Integer
Dim

Do...Loop

Exit

Exp(Double) As Double

False

Floor(Double) As Double

For...Next

Format(Double, String) As String
Function

Goto

Hex(Integer) As String

If...Then...Else

InStr(Integer, String, String) As Integer
InStrB(Integer, String, String) As Integer
Left(String, Integer) As String
LeftB(String, Integer) As String
Len(String) As Integer

LenB(String) As Integer

Log(Double) As Double
Lowercase(String) As String
LTrim(String) As String

Max(Double, Double) As Double
Microseconds As Double

Mid(String, Integer, Integer) As String
MidB(String, Integer, Integer) As String
Min(Double, Double) As Double
NthField(String, String, Integer) As String
Oct(Integer) As String

Pow(Double, Double) As Double

Redim

Rem

Replace(String, String, String) As String
ReplaceAll(String, String, String) As String
Right(String, Integer) As String
RightB(String, Integer) As String

Rnd As Double

Round(Double) As Double
RTrim(String) As String

Select Case

Sin(Double) As Double

Sqrt(Double) As Double

Str(Double) As String

StrComp(String, String, Integer) As Integer
Sub

Tan(Double) As Double
Titlecase(String) As String

Trim(String) As String

True

Ubound(array) As Integer
Uppercase(String) As String

Val(String) As Double // scientific format not recognized
While...Wend

Commands and Functions:
FillColor() as color-returns the current user selected fill color
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LineColor() as color-returns the current user selected line color

Color Funtions:

RGB(red as integer,green as integer,blue as integer) as color-returns the color from the value given, use values between
gf/li?(cya as double,magenta as double,yellow as double)-returns the color from the value given, use values between 0-
IIJISV(hue as double,saturation as double,value as double)-returns the color from the value given, use values between 0-
;electCOIOr(BYREF ¢ as color, msg as string) as boolean

Picture Class:
Constructor:
picture=newpicture(width,height)

Properties:

Height as integer
Width as integer
Depth as integer

ForeColor as Color

Pixel(x as integer,y as integer) as color
PenWidth as integer

PenHeight as integer

Mask as picture

Bold as Boolean

Italic as Boolean

Underline as boolean
TextSize as integer
TextFont as String
TextHeight as integer
TextAscent as integer
StringHeight(text) as integer
StringWidth(text) as integer

Methods:

GetSelectionleft() as integer//get the x position of the selection
GetSelectionTop() as integer//get the y position of the selection
GetSelectionWidth() as integer//get the width of the selection
GetSelectionHeight() as integer//get the height of the selection

Drawpicture picture,x,y[,DestWidth,DestHeight,SourceX,SourceY,SourceWidth,SourceHeight]
FillRect x,y,width,height

ClearRect x,y,width,height

DrawRect x,y,width,height

DrawLine x1,y1,x2,y2

DrawPolygon Points() as integer

FillOval x,y,width,height

DrawOval x,y,width,height

FillRoundRect x,y,width,height,OvalWidth,OvalHeight
DrawRoundRect x,y,width,height,OvalWidth,OvalHeight
DrawString Text,x,y,[ WrapWidth]

Effects: //amount=Value between 0-1
Grayscale

Invert

Blur

FlipHorizontally

FlipVertically

SkipLine
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Delnterlace

Tint(amount as double, color as color)

Darken(amount as double)

Lighten(amount as double)

Twirl(amount as double)

Pixellize(amount as double)

Noise(amount as double)

NoiseMono(amount as double)

Fracture(amount as double)

Bevel(amount as double)

Filter(FilterType as integer,weight as double)//weight: between -1 & 1

Rotate90()

Rotate(Angle as integer,BackColor as color)//Angle is between 0-360 Degrees; BackColor is the background color of
the rotated image

Resize(width as integer,height as integer)

AdjustColor(valuel as double,value2 as double,value3 as double,mode as integer)//values between -1 & 1, mode
0=HSV, mode 1=RGB, mode 2=CMY

ChangeColor(color,hue as double,saturation as double,value as double,weight as double)

Threshold(rangeStart as double,rangeEnd as double,obscure as double)//values between -1 & 1
KeyOutColor(color,colorTrans as double,tolerance as double,smooth as integer,shrink as integer)//colorTrans: between
-1&1

ContrastBrightness(contrast as double,brightness as double)//values between -1 & 1

Anaglyph(p as picture)

GamaFilter(red as double,green as double, blue as double)//values between 0.2 and 5.0

ColorFilter(red as integer,green as integer, blue as integer)//values between -255 and 255

Folderitem Class

Constructors:

Folderitem=GetOpenFolderItem()
Folderitem=GetSaveFolderltem(name as string)
Folderitem=SelectFolder
Folderitem=Volume(VolumeNumber as integer)
Folderitem=TrashFolder
Folderitem=DesktopFolder
Folderitem=PreferencesFolder

Properties:

Name as string

Path as string
MacCreator as string
MacType as String
Exists as boolean
Directory as boolean
Count as integer

Methods:

openaspicture() as picture
Parent as Folderitem

Child as Folderitem
MoveFileTo(Dest as folderitem)
CopyFileTo(Dest as folderitem)
Delete

Others:

OpenDocument f as folderitem//opens the file using the appropriate editor
viewmovie f as folderitem//opens in view mode

CloseWindow//closes frontmost window

MouseX as integer//mouse X in paint canvas

MouseY as integer//global mouse Y in paint canvas

gMouseX as integer//global mouse X

gMouseY as integer//global mouse Y

UserCancelled as boolean
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DoSave

DeleteSelection//deletes selected clips, frames, or portion of movie
SetGraphicSelection x,y,width,height//sets the selection region of graphic
beep [amount as integer] -plays the system beep

msgbox string/integer -displays a message box containing the value
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